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MultiCAM Mil/

Computer Aided Design and Manufacturing Software

Getting Started
With
MultiCAM Mill

Thank you for purchasing the MultiCAM Mill Computer Aided
Manufacturing software. This manual contains a command
reference section and a tutorial section. Please read both
thoroughly before using the software. Later you may refer to
the reference section as needed.

Minimum System Requirements
An IBM PC XT/AT or 100% compatible
MS-DOS or PC-DOS version 3.1 or later.

An EGA or VGA monitor and display adaptor.
A Microsoft compatible mouse.

Installing MultiCAM Mill on a Hard Disk

With the computer turned on and at the C. \ > prompt, do the
following:

1. Put the MultiCAM Mill diskette in drive A:

2. Type:
A

3. At the A:\> prompt, type:
| NSTALL
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Figure 1.1.1 Security Key

Installing MultiCAM Mill on a Floppy Disk.
While a hard drive is recommended,; it is possible to operate
MultiCAM Mill from a floppy disk. You will need a high density
disk drive; a 1.2Meg 5.25" or a 1.44Meg 3.5" will do.

To prepare a bootable disk perform the following:

1. Formatablank 1.2 Meg or1.44 Megdisk usingthe /S option
as follows:
Format a: /s

2. Copy the COMMAND.COM and the MOUSE.COM files from
your dos diskette to this new disk.

3. Copy all files from the supplied disk(s) to the new disk.
4. Insert the new disk and reboot by pressing the
<CTRL><ALT><DELETE> keys simultaneously. You

Should see the design screen illustrated in Fgure 1.1.1.
Study the items shown on the screen.

Installing The Security Key

Install the security key (see Figure 1.1.1) on a parallel port on
the computer. It can be attached to either LPT1, LPT2, or LPT3.

Tighten the screws using a small screwdriver.

Starting MultiCAM Mili
mportant: Multicam Mill will not run properly in a DOS

shell under Windows. Exit Windows before running. **
At the DOS prompt (C: \ >), type the following:

CD\ MCAM <ENTER>

MOUSE <ENTER>

MCAM <ENTER>

This will start the MultiCAM Mill software.
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Pull-Down
Menu

Command
Reference

Figure 1.1.2

MultiCAM Mill Design Screen
Visual Grid Lines
(0.0) Origin
Reference Marker and Too/

Start Position

Start Point Marker

Observe the top line of the screen in Figure 1.1.2. Each word
is a heading for a pull-down menu. The pull-down menu will
appear when the heading is selected by the mouse or key-
board.

Pull-down Menu Headings  Drawing Name

e i

Number of entities Number of Current Zoom Level Position counters
n design 700/ Paths

To access a pull-down menu, use the mouse to position the
arrow on top of a pull-down menu heading and click the left
mouse button. Alternatively, you can use the keyboard to
access a pull-down menu by pressing <ALT> and the first letter
of a heading.

Once the menu is in view, you can select any of its options by
positioning the arrow on the option and clicking the mouse
button.
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Flye Menu Selecting the File Menu produces the list of options shown in

Figure 2.1.. Some of the selections have Hot Keys associated
with them. Hot keys allow access to a command quickly

ISP Switch Edit  Draw through the keyboard and they are indicated to the right of the
selection. For example, the Hot key used to load a drawing is
ad. .. Ctrl+L <CTRL>-L which means holding down the Ctrl key and press-
yevert to saved ing L simultaneously.
port DXF File...
Ctrl1+S _ _
Ctrl+A The letters in reverse or other color than the rest of the option
: text are called QuickSelect keys. These allow access to a
elete file... . .
command only while the pull-down menu is displayed.
grint Pic:ature. ..
Save Picplure .
Eieu Picture... File-New . . .
DOS Sfell Clears the design in memory and establishes the defaults for a
- new drawing.
ERit g
File-Load
Displays the dialog window shown in Figure 2.1.1. which
F/:qure 21 displays all designs in the current directory. Just double click

on the file name to load it.

File Tailbch Edit Oraw View Oplionz CHH Hilp
Diduiai i v oL AL Ll 5
Drasiiveg File %Selector

File Hane : | DNETH
I RS

BireDrivax

i . ixldn
azel  cdn

K . il
puran Ld . cdn

pﬂrnnldz cidn
enpnthd  cdn

¥

Ewlitimer @ Tool Palhzi B Zaan =l ¥ -D.38E1 ¥ 1.377% T -0.1500

Figure 2.1.1 Load File Dialog Window

File-Revert to Saved
Reloads the last saved version of the current drawing.
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File Menu

File Switch Edit Draw

ad... Ctrl+L
swevert to saved
port DXF File...
Ctr1+5
Ctr1+A

elete file...

grint Picture... F10
Save Picfure F8

Jiew Picture...
oS sfell

ENit

Figure 2.1

File-import DXF File

ReadsinaDXF “drawing exchange file” created with AutoCAD®
or other drafting program and coverts it to MultiCAM™ format in
memory. A dialog window will appear on the screen (see
Figure 2.1.2) allowing you to select the desired DXF file using
the mouse or keyboard. Refer to the Edit-Move Profile com-
mand to align the profile if necessary. Importing a DXF file
allows you to use drawings originally created with other CAD
software without having to draw it from scratch. Lines or arcs
that are not related to the profile of the part design such as auto-
dimensioning lines may need to be deleted after importing the
drawing.

I i Tt B Chl Hi= | |2

1 BF Flile Selector |

File Hane : | O |
I3 FC R

Flilles FlirasTy ives

Files!
-1
-B-]
-1
-1

Figure 2.1.2 Import DXF File Window

File-Save

Quickly saves the current design to disk. If the design is a new
one this command allows you to enter the name of the design.
The Extension .CDM is automatically assigned.
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File Menu

File Switch Edit Draw

ad... Ctrl+L
swevert to saved
port DXF File...
Ctr1+5
Ctr1+A

elete file...

grint Picture... F10
Save Picfure F8

Jiew Picture...
oS sfell

ENit

Figure 2.1

File-Save as...

Allows saving a design to a new file name or disk/directory.
Displays the dialog in Figure 2.1.3 to select the disk/
directory. The Extension .CDM is automatically assigned.

File Swmibch Edil Draw UVima Dplion= CHH Halp
Doraa g UL P Lad 3

hy

Evbtitime:! @ Tool Pathz! D Torwn=F | X -mdAn2d ¥ 1513 7 -0, 1500

Figure 2.1.3 Save As Dialog Window

File-Delete

Deletes an existing part program from the disk. The CAD File
Selector dialog window appears and allows the user to
choose a part program in the current directory. Use the
Dir/Drives box to change to other drives and directories.
Choose the OK box when the correct filename appears in the
File name box. See Figure 2.1.1

File-Save Picture

Saves the current graphics screen to a CAMPI Cnn. PCX file
where nn is an integer from 01 to 99 and is incremented by 1
each time this option is used. The file is saved to the current
directory.

File-Print Picture
Prints the current graphics screen on the printer specified in the
PRINTER OPTIONS dialog window.
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File Menu

File Suwitch

Edit

swevert to saved
port DXF File...

elete file...

Save Picfure
Jiew Picture...
DOS Sfell

ENit

Figure 2.1

ad... Ctrl+L

Ctrl+S
Ctr1+A

grint Picture... F10
F8

Draw

File-View Picture

Displays a previously saved picture on the screen. The PCX
File Selector dialog window allows the user to choose the
picture to be viewed from the current directory. Use the Dir/
Drives box to change to other drives and directories. Choose
the OK button when the correct filename appears in the File
name box. See Figure 2.1.4.

File Switch Edit Draw Wiew Opflons CAH  Help

B vy sl 14 Led >
1 P File Selector f

File Hane : | S

15 S HURH

Files Pirs Trives

npichl.pca campicOV . pox
apicl?.poy campicOl . pox
srpicld.pox compicls. pox
siplcld . pox campicld. pox
anp lelh. pox campicll.pox
i Lelf . pox canpicl®. pos

[>]

]

Emtities: O Tool Paths: D 4 =034 Y 08771 £ -0.1500

Figure 2.1.4 PCX File Selector Window

File-Dos Shell
Temporarily exits to DOS and allowing you to execute most
DOS commands. Type EXI T at the DOS prompt to return to
MultiCAM Mill.

File-Exit
Exits MultiCAM Mill software and returns control to DOS.
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s W/'fcﬁ Menu The Switch Menu shown in Figure 2.2provides quick access

to Manufacturing and CNC file editing software.

Swuitch IEHEEIETEEEH Switch-To MK Editor
Exits the MultiCAM Mill program and initiates the MK editor.

¥
m This is a full text editor used to create and edit part programs.
to MillMaster [yro (Refer to MK Editor Manual for more information).
Switch-To MillMaster Pro ™
F/:qure 22 Exits the MulUCA_M_Mlll program a_md initiates the I\/_I|I_IMaster
Pro program. This is the full function G-code Machining and

simulation software. (Refer to the MillMaster Pro manual for
more information).
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Eait Menu

zdit Draw View

elete
Py
Paste

Jlip Arc
Reverse [ir
fJoin Endpoints

Hofe End-Point
Hreak segment
Change Jadius
ve Profile
rim Entity
nter Position
Entity [info

— [T - T oM

Figure 2.3

0

The Edit Menu shown in Figure 2.3 provides access to func-
tions that alter or modify a design. All of theses selections have
Hot Keys associated with them. Hot keys allow access to a
command quickly through the keyboard and they are indicated
to the right of the selection. For example, the Hot key used to
undo a line just drawn is the Escape or <Esc> key.

The letters in reverse or other color than the rest of the option
text are called QuickSelect keys. These allow access to a
command while the pull-down menu is displayed.

Edit-Undo

Erases the last entity drawn or reverses the last function
performed. If the last operation was an undo then selecting
undo again will return the drawing to the status it was in before
the first undo.

Edit-Delete
Erases a drawing entity from the screen. Select this menu
option then position the mouse pointer near the entity and click.

Edit-Copy
Copies a profile into the Paste Buffer .

1. Selectthis command then position the S7TAR7 MARKER to
the beginning of the segment and click the right mouse
button or press the </VSER7>key on the keyboard.

2. Point to the segment desired and click the right mouse
button.

Edit-Paste

Copies the Paste Bufferto the current STAR7 MARKER. The
Start Marker automatically advances to the next copy position
for quick repeat paste commands.

Edit-Flip Arc

Quickly changes between concave and convex arcs. Select
this command then position the arrow next to the arc you want
to change and click the left mouse button.
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Eait Menu

Draw Vieuw

elete
Py
Paste

Jlip Arc
Reverse [ir

Boin Endpoints
Hole End-Point
Hreak segment
Change Jadius
ve Profile
rim Entity
Iter Position
Entity [info

— T -] T o=

Figure 2.3

Oy

Edit-Reverse Arc Dir

Quickly changes between clockwise and counterclockwise
arcs. Select this command then position the arrow next to the
arc you want to change and click the left mouse button.

Edit-Join End Points

Connects two end points of lines or arcs with a straight line.
Select this command then position the arrow pointer between
the end points you wish to join and click the left mouse button.

Edit-Move End-Point

Allows the user to relocate one or more end-points in the profile
to anotherlocation thereby stretching, adjusting the taper angle
or eliminating a segment.

Edit-Break Segment
Splits one segment in two at the location you specify maintain-
ing the same radius or taper angle for both new segments.

Edit-Change Radius

Allows the user to specify the exact radius for an arc. Select this
command then position the arrow next to the arc you want to
change and click the left mouse button.

Edit-Move Profile

Allows repositioning the complete design relative to the origin.
Position the S7TAR7 MARKER at the desired destination point
then position the arrow on a point on the design profile you
would like to be positioned at the S7TAR7 MARKERthen click
the left mouse button.

Edit-Trim Entity
Allows the user to trim away overlapping entities to make a
clean, continuous intersection.

1. Choose the section of the entity you want to trim off.

2. Select the entity that you want to trim to by positioning the
arrow over that entity and pressing the left mouse button.
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Ed/f MeﬂU Edit-Enter Position

Allows the user to position the cursor at an exact position by
entering the coordinates on the keyboard. Select this com-

Draw  View 0O mand and type the X and Y coordinates in the dialog window

of the location. Press the <ENTER> key NOT the mouse

elete button. The Arrow will be positioned precisely at the desired
Py coordinates. You should use the keyboard <enter> key to finish
Paste a segment you are drawing or </V'SERT>key to reposition the

start marker.

Jlip Arc
Reverse [ir

Boin Endpoints
Hole End-Point
Hreak segment
Change Jadius
ve Profile
rim Entity
Iter Position
Entity [info

Edit-Entity Info
Displays the numeric information of a segment.

— T -] T o=

Figure 2.3

Page 14 MicroKinetics Corporation Document Revision B5



2 MultiCAM Mil/

Computer Aided Design and Manufacturing Software

The Draw Menu is used to select the drawing mode using a

D/'aW Meﬂl/ line, rectangle, arc, or circle. Some of theses selections
have Hot Keys associated with them. Hot keys allow access
U View  Opti; to a command quickly through the keyboard and they are
e —— indicated to the right of the selection. For example, the Hot
Hectangle key used to select line mode is the <L> key.
Arg s
| Sirele © Draw-Line
Select Selects the straight line pen mode for drawing vertical, horizon-
Ullselect . .
Thselect All tal, and tapered lines at any angle. Note the selection check

mark on the left of the word, Line, in Figure 2.4. This mark
indicates thatthe line mode s currently selected. Todrawaline,
. just reposition the STAR7 MARKER, if necessary, position the
F/gUfe 24 arrow (end marker) at the end of the line, and click the left
mouse button.

Draw-Rectangle

P1
Selects the Rectangle Drawing mode. To draw a rectangle,
simply place the S7AR7T MARKER at one corner of the
rectangle and position the arrow (end marker) at the diagonal

P2 :
corner and click the left mouse button.
P3 Draw-Arc

Draw An Arc Selects the Arc Drawing mode. For drawing concave and
convex arcs, all you need to do is indicate the start point, the
end point and a point on the arc. See Figure 2.4.1.
P1 P2 1. Position the start point (P1) and press the right
mouse button to relocate the S7TART7 MARKER.
2. Position the arrow to the end point (P2) and click
Draw A Circle the left mouse button.

3. Position the arrow to a point (P3) that the arc
passes through and click.

Figure 2.4.1
Circle and Arc Point praw-Circle
Placemenis Selects the Draw Circle mode. To draw a circle, simply place

the START MARKER at one point (P1) on the circle and
position the arrow and click the left mouse button at each of two
other points on the circle (P2 and P3). See Figure 2.4.1.
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Draw Menu

Mectangle R
Fiys 4]
ircle C

Jelect

Ull=elect
Ihselect All

Figure 2.4

Draw-Select

This allows the user to select entities on the screen. Drawing
entities must be selected prior to using the CAM-Verify/
Accept Pocket and CAM-Verify/Accept Island functions.

Draw-Unselect
This allows the user to unselect an entity that is currently

selected.

Draw-Unselect All
This unselects ALL selected entities.
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View Menu

Options CAM Help

Ctrl+C
Ctrl+]
Ctrl+0
Ctrl+F

Benter
Zoom
Zoon Dot
Full View

Il Show Part Telplate
. Shouw End Harkers
| Show tool Faths
Il Bool Radius outline

Toggle Culur/EH Fa

Figure 2.5

Redrauw Ctrl+R

The View Menu allows you to change the way you see the
design. See Figure 2.5.

View-Redraw
Regenerates the graphics at the same zoom level.

View-Center
Centers the display around the S7TAR7 MARKER.

View-Zoom In
Magnifies the area around the S7ART7 MARKER.

View-Zoom Out
Condenses the area around the S7ART7 MARKER.

View-Full view
Zooms in or out as necessary and centers the part on the
screen.

View-Show Part Template
Enables/disables the part template under the design.

View-Show End Markers
Enables/disables the display of segment end markers, this
visually indicates the beginning and end points of all segments.

View-Show Tool Paths
Enables/disables the display of the tool path entities computed
by MultiCAM Mill.

View-Tool Radius Outline
Enables/disables the display of tool radius lines which provide
a realistic view of the tool path.

View-Toggle Color/BW
Toggles between Color and Black & White. For best results,
change to B&W just before a screen dump.

Document Revision B5

MicroKinetics Corporation

Page 17



MultiCAM Mil/

2

‘Computer Aided Design and Manufacturing Software

Options Menu

Drawing Title Block...
G—code #Montrol Setup...

rid Selections...
Igrinter Options...

Save As [efault

evert to Saved Defaults
IBoad Setup...

wave Setup

Save Setup T=...

Drawing Area ®olors...
Henu & Jindow Colors. ..

Figure 2.6

The Options menu is used for configuring the system, setting
up Metric or Inch programming, specifying printer type and port
selection and setting up the G-code Post-processor. The
Options menu also allows changing the colors for all the
individual functional areas of the system. See Figure 2.6.

Options-Drawing Title Block

Allows you to enter the Drawing Title, Designer Name, Revi-
sion, Date, Material used, Part Length, Width, and Height, and
to specify mm or Inch units of measure. See Figure 2.6.1.

Cuwitch Edit D i View Opt fons AR Help
D U =5 0het At Ded >

: I UI'II.Ii.Ilu.'iLll-! Hloi:k I

Brawing Title: | ZoICH

Designer Hanpe ! | Jobn Dos

Hhulalnn=lﬂ Ditn=lﬂ?—29-1ﬂﬂi Hatnrni]=|!ax

i ts Fart Length: = EIHEIEN IH fdth: | 2 LI |
= Imch LB [
an
Part Haight ! [ Rccapl

LEY

&

ies: 0 Tool Paths: O Zoom=¥ 1 ¥ 1.1980 Y Z.0348 Z -0.4

Figure 2.6.1 Drawing Title Block Window

Options-G-code Control Setup

Allows the user to enter the tool start and change position,
specify the appropriate work hold method, and the path the
CNC file will be directed to when compiled by MultiCAM Mill.

See Figure 2.6.2.
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Options Menu

Drawing Title Block...
G—code #Montrol Setup...

rid Selections...
Igrinter Options...

Save As [efault

ad Setup...
ve Setup
Save Setup T=...

Hevert to Saved Defaults
[y

Drawing Area ®olors...
Henu & Jindow Colors...

Figure 2.6

Fils Switch Edit Drew View Opiions CAH  Holp
Do v SR L Limid

E-code Combrol Paraneters

Start Pogd :-::lﬂ J '.-.l n

Tool Change? :-::| D '.'=| 0

Dutput CHC file tu:l

K imitonatic Commenils
H-urh Hald Method

fHagnelic Chickl
* {Hold-Dioun Clangs

Ewtitiea: U lool Paths:= O L0 A LZ1HE ¥ LB L i 1L

k

Figure 2.6.2 G-code Setup Dialog Box

Options-Grid Selections

Allows the user to select a Visual Grid size, a Cursor Grid size
and to individually enable or disable each. Also, pressing <G>
toggles both grid selections. See Figure 2.6.3.

File Switoh Edit Draw View Opfions CAH lelp
Prawing Hlntitled?

] Grid] L;ut.l.ﬁ
Visual Il:r:u:l:|

Cuirane La-id: | N

¥ Vignal Grid Enabled

% Cursor Grdd Enahled

Ewtitiez: © Jool Patha: B Fi ; JpsE Y N A L

Figure 2.6.3 Visual and Cursor Grid Setup
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Options Menu

Drawing Title Block...
G—code #Montrol Setup...

rid Selections...
Igrinter Options...

Save As [efault

bevert to Saved Defaults
IBoad Setup...

wave Setup

Save Setup T=...

Drawing Area ®olors...
Henu & Jindow Colors...

Figure 2.6

Options-Printer Options
Allows selectionof LPT1, LPT2, or LPT3 for the printer port and
the type of printer (Epson/IBM) or LaserJet. See Figure 2.6.4.

Switch Edit Draw Uiew Opt iows CAH e I p
Do i vy € Dbt B Dol >

Frinter Dptions |-

Frinter Fort Frinter Typs
&= {LPT1> <EPSONS THE:
LLPTE> + {LASERJET

LLPT3>

fem i O lTool Paths: O o= 1

Figure 2.6.4 CNC Printer Options

Options-Save As Default

Stores all the current settings to the default configuration file.
All the options as set will be stored on disk and will be in effect
upon first executing MultiCAM Mill or upon starting a new
drawing by selecting File-New.

Options-Revert to Saved Defaults
Clears current settings and restores the defaults from disk.

Options-Load Setup

Allows the user to load a setup file. A setup file has a .MSU
filename extension and configures MultiCAM Mill with the
setup parameters in the file. This allows the user to quickly
change between different setups.

See Figure 2.6.5.
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Options Menu Bk

Sebup File %leclos

Flle Hane: | SEETN

G A

Drawing Title Block...
G—code #Montrol Setup...

Files Dirs I ives

ill.nsu
roMLEr ASU

rid Selections...
Igrinter Options...

Save As [efault
ggvert to Saved Defaults

IBoad Setup...
wave Setup
Save Setup T=...

I Ok I Cancizl

Drawing Area ®olors...
Henu & Jindow Colors. ..

by
Evtitims: @ Tool Paths! D ¥ 1.2089 ¥ 1,160 T -0.1000

Figure 2.6.5 Setup File Select Window
Figure 2.6 .
Options-Save Setup
Saves the current setup parameters to the current setup file.

Options-Save As
Allows the user to save the current setup parameters into a
setup file. See Figure 2.6.6.

P imis Dt it ChiE Hi= | ¢
i f g Dk Bt Dl

1| Gave Getup R

File Hane : | JEBCEIN
[P o

Figure 2.6.6 Save Setup As Window
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Options-Drawing Area Colors
y Allows selection of colors for the design area. This includes the
Opflons MeﬂU part fill color, the background color, the draw pen color, the
roughing cuts color etc.. See Figure 2.6.7.

Drawing Title Block...
G—code #Montrol Setup...

Switch Edit Drass W e Dptioms  CAH Help
Do e iy s Uit it Lisdd >
Irawing Area Color Sedup

Background Color

rid Selections...
Igrinter Options...

Fart Fill Color

Save As [efault
ggvert to Saved Defaults

Braw Pan Colar

[ = T
=

IBoad Setup...
wave Setup
Save Setup T=...

Entily Seleck Calar

& |

EnLily Aoccepl Colar

Wigwal Grid Coloe

Drawing Area ®olors...
Henu & Jindow Colors. ..

Dy gy lie Marker Color

coaplt

Figure 2.6

Figure 2.6.7 Drawing Color Setup Window

Options-Menu & Window Colors
Allows selection of Menu and Text colors for the pull-down
menu’s and the Dialog windows. See Figure 2.6.8.

Fille Switch Edit Daras Uiea Oplions CHH Help
Prawimng “tlint it led?
Hera Lolors Setup

bar ites zelected
bar &lt-key sotive
option enabled
aplion dizab led
opbion Hot key

iy welirdik |

Forsgrouml Calar [ l ¥

Backgrowed Colar Tl

lﬁ'mpLI I Cancul I

EwbLiliex: 0 Tool P 065534 hII. 1500

Figure 2.6.8 Menu Colors Setup Window
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CAM Menu

Select Tool... Ctrl+T
Pocketing Specs... Ctrl+P
Verify-Accept Egcket
VerifysAccept land

Hough Cut Pocket Cirl+K

Place ijinish Path Cirl+H
Add Jachine Cycle...

ndo Last Place
iMit Path/cuycle...
lear All Paths

Citrl+N

Hake CJC File
Eruuse CHC File...

Figure 2.7

The CAM menu contains functions to select the current tool, to
enter pocketing specifications, to rough and finish cut pockets,
and to create CNC program files. See Figure 2.7.

CAM-Select Tool
Allows the user to enter the diameter of each of six tools and to
select the current tool to be used. See Figure 2.7.1.

File Sweitch Edit  Draw  Wew Optloms  ©CAE Help
D ai i ng UL Led >

Toml Select & Pefimilion
Turret Tonls
t Twiztl Brill Di-nﬂlur:| B, 15 |
¢ Bpok Face Tool
I Hill Cutter
¢ Hall-Ewd Cukler
¢ T=5lot Cutter
i Dowon-Tall Cwtter

Edit 0 d:jHill Cutter l

Tool Path Color [T W

1

Entities: B Tool Paths: @ Eooe=i 1 ¥ 1.9358 Y Z.oo4E T -0.1Y

Figure 2.7.1 Tool Select Dialog Window

CAM-Pocketing Specs

Allows the user to set the pocketing and profiling parameters
used by the CAM-Rough Cut Pocket function. Enter the start
and final pocket depths, specify the amount of material to be left
for the finishing cut, enter the spacing between successive
roughing cuts, and the maximum cut depth of the roughing cuts.
Enter the feed rates the post-processor will use, and specify
cutting direction. See Figure 2.7.2.
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Edit Draw View Options CAH Help

C‘AMAJe”U : i i Drawing:iUntitled> | | | | ¢
Pocketing & Profiling Parameters

Final Depth: || EN Start Depth:| O

Rough Clearance X&Y:| .005

Select Tool... Ctrl+T
Pocketing Specs... Ctrl+P
Verify/Accept Egcket Rough Cut Spacing:| .05
VerifysAccept land

Bough Cut Pocket  CirlsK Cut Depth Per Pass:
Place ijinish Path Cirl+H

2| Add Jachine Cycle... Feed Rates: (Rough)| 5 (Finish)| 4

ndo Last Place {Normal Feed Only}
#dit Pathscycle... {Climnb Hilling only> “ﬂccept
lear All Paths

* {Bidirectional>

Hake CJC File Cirl+H
Eruuse CHC File...

jes: B Tool Paths: @  Zoom=X 1 X 1.5398 ¥ 1.

Figure 2.7.2 Pocketing Specs Dialog Window
Figure 2.7

CAM-Verify/Accept Pocket

This function uses the entities currently selected with the Draw-

Select function to define the border of a pocket. This function

checks the part profile for any errors during this operation.

CAM-Verify/Accept Island

This function uses the entities currently selected with the Draw-
Select function to define the border of a island. This function
checks the part profile for any errors during this operation.

CAM-Rough Cut Pocket

This function uses the previously accepted pocket and island
borders and creates a tool path for the roughing cuts of the
pocket.
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CAM Menu

Select Tool... Ctrl+T
Pocketing ¥pecs... Ctrl+P
VerifysAccept lyocket
VerifysAccept land

Hough Cut Pocket Cirl+K
Place Jinish Path Cirl+H
Add Jachine Cycle...

ndo Last Place
#dit Pathscycle...

lear All Paths

Hake CJC File
Eruuse CHC File...

Figure 2.7

CAM-Place Finish Path

Allows the user to place a finish cut path along any section of
the part profile. Simply click the left mouse button near the start
of the path then again in the direction of the path and finally on
what side the tool is to cut on. If there is an intersection or an
ambiguous entity path, then use the Draw-Select function to
define the section of the part profile to be considered.

CAM-Add Machine Cycle
Allows the user to easily use a canned drilling or boring cycle
in the current design. See Figure 2.7.3.

1. Position the start point and press the right mouse
buttontorelocate the S7TAR7 MARKEROr choose
<ALT>E-E and enter the exact position needed.
Press the <INSERT> key to move the S7TART
MARKER to that position.

2. Choose <ALT>C-M and the Cycle Select and
Definition Dialog Box with appear on the screen.

3. Choose the appropriate cycle and enter proper
specifications. Choose [ACCEPT].

A cycle icon "@ " will appear at the S7TART7T MARKER position
indicating a canned cycle.

Film Switch FEdit Dram Uimw Opkionz CAM Ha |
Divaw imeg 1XUnd ik Uod &

Dz ln Soleck & Dufimition

Canned cuyzlex
Final Depth :@
1 GRR=5pok Face

GA3=Deep Hole
LAS=EBrring Hole [neyr Ihplh:lEl
GAT=Beep Hole ~Chip

GA9=Bor ing HeDual |
- “'""“l:l
Edit B 11
Frund Etlul@
GAl=0rill Hala

b

Enkiting! B Toonl Palhz! O X N ' 1.2943 £ @, 1500

Figure 2.7.3 Cycle Selection Dialog Window
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CAM Menu CAM-Undo Last Place

Removes the last roughing or finishing cut path from the
screen.

Select Tool... ctr1+T |lf CAM-Edit Path/Cycle

Pocketing Specs... Ctrl+P E

Vo i fu/Pacant Ecket Allows the user to edit a tool path or cycle.
Verify/Accept li=land
See Figure 2.7.4.
Bough Cut Pocket  CirlsK
Place ijinish Path Cirl+H
Add Jachine Cycle...

ndo Last Place
iMit Path/cuycle...

lear All Paths

Film Switch Edit Dram Uinw Options CAM Ha lp
Diraw imeg IXUng ik Dad &

VisuwsEdit Path Sagrembz

Start Painid !li:l 1. 0ETS I ¥ | A.7ITS |

Hake CJC File Cirl+H
Eruuse CHC File...

Emal Painil :i:l 1. 5325 I ¥ | A.7ITS |

Conter Paintl k:l @, n00n I ¥ | 0. nnpn |

F/.gUer.7 Eﬂu:p-k'h:l-l'l.lmll"ﬂl B T-:ml:lil
E B B Bl E

Entikine! B Tool Palhz! 8 X 15665 % 1.0037 T -@,lo0n

Figure 2.7.4 Edit Path/Cycle Dialog Window

CAM-Clear All Paths
Removes all the paths currently on the screen.

CAM-Make CNC File
Generates the G-code file for use with the Mill Master Pro CNC
Machining and Simulation software.
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CAM MeﬂU CAM-Browse _CNC File _ _ _ _

Allows you to view a CNC file on screen. This provides a quick
look at the code generated without having to exit the program.
See Figure 2.7.4.

Select Tool... Ctrl+T
Pocketing Specs... Ctrl+P
Verify-Accept Egcket
VerifysAccept land

File Switch Edit Draw View Options CAH Help
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iMit Path/cuycle...

lear All Paths

G :NHCAMN,
Files Dirs/Drives
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Figure 2.7
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Figure 2.7.4 CNC File Browse Window
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Help Menu

Program Qevision
llemory Usage

Figure 2.8

The Help Menu contains selections that allows the user to view
the help dialog box, identify the revision of the software, and
view the current amount of memory being used.

See Figure 2.8

Help-View Help

This will display a window of instructions on how to use the
mouse and the keyboard to use the functions of this software.
The window has a vertical scroll bar on the right. Click on the
upper arrow to go down and the Upper arrow to go up. Click
anywhere in the middle to close the dialog window.

See Figure 2.8.1.

Help-Software Revision
This will display the revision of the software that is currently
being used.

Help-Memory Usage

This will display the number of lines in the current part program,
the amount of available part program memory, and the total
amount of conventional memory available.

File ZSwitch Edit Draw View Opiions CAH Help
Prawing SUnt it leds

SELECTING FULL MIHH HERIE

Using the House

Pagilion the pouse poinbsr Lo Lhe desired peso
Litle and CLICK the left souwes bitton, Thiss
pazltion the mouse podnter to the desired option

and CLICK the lelt mouss bakton.

Eeing Lhe Keyboard
Pall doun sAenus are selected by asing the (ALTY key
in conbhination with the 1st letier of a pesu title.

Ewtities: 0 Ioal Patha: O ! BT Y & = 1540

Figure 2.8.1 Help Window
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Configuration

& Setup
(Milling Example)

Dessiing Title Blook

Trved L et TIl-Ie:lE-:Mpla 11

LERRETTLT Il.ma:l\‘wr* e
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= Inoh
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Figure 3.1
Drawing Title Block
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¥ fmtonstic Conmantz
Hork-Hald Hathod

tHagrutic Checks
# tHold-loun Clenpe’ m

Figure 3.2
G-code Control Setup

This section will show you how to configure MultiCAM Mill.
Follow the procedures carefully and you will quickly learn
how to design your own parts. Enter the values as indicated
below.

3.1 Drawing Title Block

1.

4.

Choose Options-Drawing Title Block with your mouse
or <ALT>-O D from the keyboard. Enter EXAMPLE 1 for
the [Drawing Title] and your name in the [Designer
Name] box. See Figure 3.1.

Leave the [Revision] as A and the [Date] is automatically
entered from the system clock. Enter Wax in the
[Material] box.

Enter 2. 0000 for the [Part Width] and [Part Depth] and
. 4000 for the [Part Height].

Click on [ACCEPT].

3.2 G-code Control Setup

1.

Choose Options-G-code Control Setup with the mouse or
<ALT>-O C from the keyboard. Enter the X, Y and Z
starting position and tool change position values. See
Figure 3.2. The starting position will be used in the G92
statement when the part program is created. The tool
will be located at the tool change position every time a
new cutting tool is selected.

Enter X =0, Y=0, and Z = 0. 05 for the starting position
and X=-1,Y =0, and Z = 0. 05 for the tool change
position.

2. Leave the [Output CNC File To] box empty. This will

send the generated CNC file to the current directory.

Choose the work-hold method. Select [Hold-Down
Clamps] for the tutorial.

. Select [Automatic Comments].

. Choose [Accept].
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Configuration

& Setup
(Milling Example)

Tool Select & Bufisitios

Blanmtnr I

Twizt Brill
5

| =
51 T-Shet Cuttesr

B BovwTail Cutier

Edit o Elllllll Cutter |

fool Fath Color [ [pee=rt]

Figure 3.3

Too/ Definition Window

3.3 Setting Tool Definitions

This section will show you how to determine your tool
geometry and enter it in MultiCAM Mill. Note: The default
tool geometry values for Tools 1-6 are set for typical values.
These should be adjusted to describe your particular tools.

Choose Tool #3 for the tutorial (0.125" Dia. Endmill).

o

. Determine the diameter of your tools.

. Choose CAM-Select Tool with the mouse or <ALT>-C T

from the keyboard. See Figure 3.3.

Enter the diameter of the tool that is selected. When
selecting a tool via the keyboard it is necessary to press
<Enter> after using the up/down arrow keys to move the
highlighter.

Highlight the next tool and repeated Step 3. Do this until
all of your tool diameters have been entered.

Choose [Accept].

3.4 Saving Parameters to a Setup File

1.

Choose Options-Save Setup As with the mouse or
<ALT>-O A from the keyboard. Enter CUSTOMWK in the
File Name box. The .MSU extension is added
automatically.

Choose [OK].

Choose Options-Save As Default with the mouse or
<ALT>-O D from the keyboard. MultiCAM Mill will
automatically be configured with these parameters at
startup.
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This section will show you how to configure MultiCAM Mill.

, 7 Follow the procedures carefully and you will quickly learn
Configuration b y and you will quickly

how to design your own parts. Enter the values as indicated

& Se[u p below.

(ROUflhg Examp/e) 3.5 Drawing Title Block

1. Choose Options-Drawing Title Block with your mouse
or <ALT>-O D from the keyboard. Enter EXAMPLE 2 for
the [Drawing Title] and your name in the [Designer
Name] box. See Figure 3.4.

Dessiiog Tikle Blook

Traasing TIl-Ie:lE-:Mpla : 1 |

LERRETTLT Il.ma:l\‘wr* e |

wuloanlmu:|ns-m-1993 [ater it = oot |

2. Leave the [Revision] as A and the [Date] is automatically
entered from the system clock. Enter Wbod in the

Unite

Part l.c-rrgl-h:l 12,0060 |I||¢u.:| 12,0000 |
Inoh (R4 [4'3]

i

rat weig | o | pocen] [Material] box.
F/'gu/-e 34 3. Enter 12. 0000 for the [Part Width] and [Part Depth] and
D/'&W/ﬂg Title Block 0. 7500 for the [Part Height].
4. Click on [ACCEPT].
‘ii-pods Confrol Parsesiors |=—
satron i@ |v:fn |z[m |fi 3.6 G-code Control Setup
Toal Changer ¥:|-1 [ v o [z s |

1. Choose Options-G-code Control Setup with the mouse or
<ALT>-O C from the keyboard. Enter the X, Y and Z
starting position and tool change position values. See

Ontpnt D4 File S0 | |

¥ fmtoaaiio Conaents
Hork—Hold Hetlod

| - iEhien P  — Figure 3.5. The starting position will be used in the G92
statement when the part program is created. The tool
. will be located at the tool change position every time a
Figure 3.5 new cutting tool is selected.
G-code Control Setup

Enter X =0, Y=0, and Z = 0. 05 for starting positions and
X=-1,Y =0, and Z = 0. 05 for tool change positions.

2. Leave the [Output CNC File To] box empty. This will
send the generated CNC file to the default path.

3. Choose the work-hold method. Select [Hold-Down
Clamps] for the tutorial.

4. Select [Automatic Comments].

5. Choose [Accept].
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3.7 Setting Tool Definitions

COHﬂgU/'af/OH This section will show you how to determine your tool geom-

& S l. etry and enter it in MultiCAM Mill. Note: The default tool
[ Up geometry values for Tools 1-6 are set for typical values.
These should be adjusted to describe your particular tools.

(Routing Example)

Choose Tool #4 for the tutorial (0.375" Dia. Endmill).

Tool Select & Definifion

1. Determine the diameter of your tools.

= Tuist Deill
= Epof Faoe Tool
= Hill Cufiier

= T-Elof Cafier
= Dorsp-Tad ] Caiier

2. Choose CAM-Select Tool with the mouse or <ALT>-C T
from the keyboard. See Figure 3.6.

Edit B 4=|B-lII-E|'|I Caliar

peer]
Tool Path Coloe [ W [0

3. Enter the diameter of the tool that is selected. When
selecting a tool via the keyboard it is necessary to press
<Enter> after using the up/down arrow keys to move the
highlighter.

Figure 3.6

Too/ Definition Window
4. Highlight the next tool and repeated Step 3. Do this until
all of your tool diameters have been entered.

5. Choose [Accept].

3.8 Saving Parameters to a Setup File

1. Choose Options-Save Setup As with the mouse or
<ALT>-O A from the keyboard. Enter CUSTOMD in the
File Name box. The .MSU extension is added automati-
cally.

2. Choose [OK].
3. Choose Options-Save As Default with the mouse or

<ALT>-O D from the keyboard. MultiCAM Mill will auto-
matically be configured with these parameters at startup.
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72/1‘0/'/3/ 4.1 Milling Example Tutorial
(M////ng Examp/e} In this tutorial you will design and edit the part in Figure

4.1.1. Before going ahead, you should first complete
Section 3-Configuration and Setup (Milling Example). This
tutorial assumes that MultiCAM Mill has been properly
installed (see Section 1- Getting Started) and is currently
running on your computer.

1.8
1.5
1.2
0.8
0.5
POCKET
0.125 DEEP
0.156 RAD
2 PLCS o
|l
Al —
e i : | N f
ot Q ~—
N’ o
©
~ <
© o
1.1
1.35
1.6
2.0

Figure 4.1.1 Tutorial Example

1. Choose Options-Load Setup with the mouse or
<ALT>-O L from the keyboard. Select MILL.MSU and
choose [OK]. This will reconfigure MultiCAM Mill with the
parameters entered in the previous section. The screen
should now look like Figure 4.1.2.
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-
mtorla/ File Switch Edit Praw View Opfions CAH  Help
Doranai vy =GR L Led

(Milling Example)

Ewtitims: @ Tool Paths! D ¥ Z.Z000 ¥ 0O.4000 T -0,1250

Figure 4.1.2 Startup Screen

2.

To draw the two rectangles, press <R> on the keyboard.
This selects the RECTANGLE drawing mode.

Locate the S7TAR7 POINT MARKERto X0.2 and Y1.8 by
positioning the mouse arrow and then pushing the right
mouse button (<RMB>).

Move the arrow to X1.8 and Y0.2 and click the (<LMB>).
You will see a square on the screen.

Draw a small rectangle by positioning the S7AR7 POINT
MARKER at X1.2 and Y1.5 and set the diagonal corner
at X1.5and Y1.1. You should now have two rectangles
on the screen.

To draw the triangle island, choose <L> on the keyboard.
This selects the LINE drawing mode.

Position the S7TART POINT MARKER at X1.35 and
Y0.85. Move the arrow to X1.6 and Y0.4 and click the
<LMB>. Move the arrow to X1.1 and Y0.4 and click the
<LMB>. Move the arrow back to X1.35 and Y0.85 and
click the <LMB>. There should now be a triangle on the
screen.
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Tutorial
(Milling Example)

8. To draw the last island, draw two more lines, one from

X0.5, Y1.3 to X0.5, Y0.6 and the second one from X0.8,
Y1.3 to X0.8, Y0.6.

. Change to ARC mode by pressing <A> on the keyboard.

You will now do the two arcs at the ends of the last
island.

10.Position the S7TART7T MARKER at X0.5, Y1.3. Move the

mouse arrow to X0.8, Y1.3 and press the <LMB>. You
will see a second small cross on the screen, these are
the two end points of the arc. Now move the mouse
arrow to X0.65, Y1.4 and press the <LMB>. You now
have an arc on the screen, but does it have the correct
radius? You can find out by pressing <I> on the
keyboard, select the arc with the mouse, and select [OK].
Change the radius of the arc to 0.156" by choosing Edit-
Change Radius and then selecting the arc. Enter 0.156
and choose [ACCEPT]. The arc should now have the
correct radius. Position the S7TAR7 MARKER at X0.5,
Y1.3 and choose Edit-Copy with mouse and select the
arc. Position the S7TART7 MARKER at X0.5, Y0.6 and
choose Edit-Paste with the mouse. A copy of the arc is
now at the opposite end of the island. To flip the second
arc, press <F> and select the arc with the mouse. The
drawing is now complete. See Figure 4.1.3.

Figure 4.1.3 Completed Part Profile
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11.Save the current file by choosing <ALT>-F A and enter

; EXAMPLEL in the F/le Name box and select [OK]. The
TUIorla/ .CDM extension is automatically added to the filename.
(M///”g Examp/e} 12.Choose Draw-Select with the mouse. This allows you to

select drawing entities so you can use the CAM-Verify/
Accept Pocket and CAM-Verify/Accept Island
functions.

13. Select all segments of the square that borders the three
islands and choose CAM-Verify/Accept Pocket. You
have now defined the border as the pocket perimeter.

14.Now select both arcs and the two lines that join them by
positioning the mouse arrow near them and pressing the
<LMB>. After all four entities are selected, choose CAM-
Verify/Accept Island with the mouse. You have now
defined this entity group as an island. Do the same for
the small rectangle and then the triangle.

15.Select CAM-Rough Cut Pocket with the mouse or
choose <ALT>-C R from the keyboard. MultiCAM Mill is
now processing the part profile and generating a tool
path. When complete, the screen should look like
Figure 4.1.4.

Fil= Switch Edit Draw Vijew Opfions CHH  Help
Ervaiiai A e = EXAMPLEL . CDH

Ewmbitiex: 15 Tool Paths: 5B X 2 £ —-0.125%8

Figure 4.1.4 Completed Roughing Cut Tool Path
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- 16.Place the finishing cuts by selecting CAM-Place Finish
7. Ul 0’ / a/ Path with the mouse or <ALT>-C F from the keyboard.
(M///”g Examp/e} 17.Position the mouse arrow near the lower left corner of

the large square and press the <LMB>. This is the
starting point (P1) of the cutting move. Move the mouse
arrow above that point and press the <LMB> again. This
point (P2) determines the direction of the cutting move.
Position the mouse arrow to the right of the vertical line
and press the <LMB>. This point (P3) indicates that th
tool compensation is to the right of the selected segment,
therefore, the inside of the square will be cut. The
finishing cut path for the border is now on the screen.
Figure 4.1.5,

@® P3

P2 @

Pl @

Sequence of Finish Path Points

18.Press <F3> to repeat the last function. Positon the

For Pockets mouse cursor near the lower left corner of the triangle
and press the <LMB> (P1). Move the mouse arrow just
F/'gure 415 to the right and press the <LMB> again (P2). Move the

mouse arrow below the triangle and press the <LMB>
again (P3). A finish cut path is now around the triangle.
Figure 4.1.6.

19.Repeat Step 18 for last two islands. The screen should
now look like Figure 4.1.7.

Film Swmibch Edit Draw Viema Oplionz CAH Halg
o Prawing (tEXAMPLEL , CDH

P1 P2

®
P3

Sequence of Finish Path Points
For Islands

Figure 4.1.6

Emtities: 1% Iool Paths: B4 v L L L

Figure 4.1.7 Completed Tool Path
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y 20.Press <CTRL>-N to the make the CNC file.
Tutorral
T In addition to the commands used in the above tutorial,
(M///”g Examp/e} there are others that you may wish to experiment with to

become a proficient user of MultiCAM Mill.
These include:

" <ESC> to undo the last drawing command.

" <DEL> to def/efe a segment.

" <F>to /jpan arc.

« <D>to reverse the arc airection.

»  <J>to /inearlyjoin two end points.

« <V>to /movean end point.

» <B>t0 break a segment in two.

«  <M>to /movethe entire profile.

« <T>to #/moverlapping drawing entites.

« <E>to enter an exactposition.
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) 4.2 Routing Example Tutorial
Tutorial

(Routing Example)

In this tutorial you will design and edit the part in Figure
4.2.1. Before going ahead, you should first complete
Section 3-Configuration and Setup (Routing Examp/e). This
tutorial assumes that MultiCAM Mill has been properly
installed (see Section 1- Getting Started)and is currently
running on your computer.

12.00
11.00
1.00 <>
POCKET ;
0.375 DEEP
°8 8
ol- N
1.125 RAD T
3 PLCS
oo
2.00 o Q
4.00 -
5.00
7.00
8.00
10.00

Figure 4.2.1 Tutorial Example

1. Choose Options-Load Setup with the mouse or
<ALT>-O L from the keyboard. Select ROUTER.MSU
and choose [OK]. This will reconfigure MultiCAM Mill
with the parameters entered in the previous section. The
screen should now look like Figure 4.2.2.
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Tutorial
(Routing Example)

File Switch Edit Drow View Opfions CAH  lelp
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Figure 4.2.2 Startup Screen

2.

To draw the outside border, press <R> on the keyboard.
This selects the RECTANGLE drawing mode.

Locate the S7TART POINT MARKERto X1.0 and Y1.0 by
positioning the mouse arrow and then pushing the right
mouse button (<RMB>).

Move the arrow to X11.0 and Y11.0 and click the
(<LMB>). You will see a square on the screen.

Draw a small rectangle by positioning the S7AR7 POINT
MARKER at X2.0 and Y8.5 and set the diagonal corner
at X4.0 and Y3.0. You should now have two rectangles
on the screen.

Erase the top line of the small rectangle by pressing
<DEL> and selecting the line with the mouse.

Copy one of the vertical lines to start forming the other
two islands. Position the S7ART7 POINT MARKER at
X-1.0 and Y3.0. Press <C> on the keyboard and select
the left-most vertical line of the small rectangle. Move
the START7 POINT MARKERto X2.0 and Y3.0 and press
<P> on the keyboard. Push <P> again.
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8. To do the remaining lines, position the S7AR7 POINT

72/ [0 ,-/'a / MARKER at Xl_.O and Y3.0. !Dres_s <C> on the keyboard
and select the right-most vertical line of the small rect-

angle. Move the S7TART7 POINT MARKER 1o X4.0 and
Y3.0 and press <P> on the keyboard. Push <P> again.
Move the START7 POINT MARKERto X5.0 and Y3.0.
Move the mouse arrow to X7.0 and Y3.0. Draw another
line from X8.0 and Y3.0 to X10.0 and Y3.0.

(Routing Example)

9. Change to ARC mode by pressing <A> on the keyboard.

10.Position the S7TART7 MARKER at X2.0, Y8.5. Move the
mouse arrow to X4.0, Y8.5 and press the <LMB>. You
will see a second small cross on the screen, these are
the two end points of the arc. Now move the mouse
arrow to X3.0, Y8.5 and press the <LMB>. You now
have an arc on the screen, but does it have the correct
radius? You can find out by pressing <I> on the key-
board, select the arc with the mouse, and select [OK].
Change the radius of the arc to 1.125" by choosing Edit-
Change Radius and then selecting the arc. Enter 1.125
and choose [ACCEPT]. The arc should now have the
correct radius. Position the S7TAR7 MARKER at X-1.0,
Y8.5, press <C> on the keyboard and select the arc.
Position the S7TART7 MARKER at X2.0, Y8.5 and press
<P> on the keyboard. Press <P> again. The drawing is
now complete. See Figure 4.2.3.

Figure 4.2.3 Completed Part Profile
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Tutorial
(Routing Example)

11.Save the current file by choosing <ALT>-F A and enter
EXAMPLE? in the F/le Name box and select [OK]. The
.CDM extension is automatically added to the filename.

12.Choose Draw-Select with the mouse. This allows you to
select drawing entities so you can use the CAM-Verify/
Accept Pocket and CAM-Verify/Accept Island func-
tions.

13. Select all segments of the square that borders the three
islands and choose CAM-Verify/Accept Pocket. You
have now defined the border as the pocket perimeter.

14.Now select the left-most arc and the three lines that join
them by positioning the mouse arrow near them and
pressing the <LMB>. After all four entities are selected,
choose CAM-Verify/Accept Island with the mouse. You
have now defined this entity group as an island. Do the
same for the other two islands.

15.Select CAM-Rough Cut Pocket with the mouse or
choose <ALT>-C R from the keyboard. MultiCAM Mill is
now processing the part profile and generating a tool
path. When complete, the screen should look like Fig-
ure 4.2.4.

File Switch Edit Drow View Opfions CAH  lelp
Ddiiad ey SEXOABPLES . CDM

Intities: 16 Tool Paths: 153 Zoom=l 1 4 13.5000 ¥ & =0. 3750

Figure 4.2.4 Completed Roughing Cut Tool Path
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16.Place the finishing cut paths by selecting CAM-Place

- Finish Path with the mouse or <ALT>-C F from the
Jutorial cevbonrd
(ROUf/ﬂg E)(amp/e) 17.Position the mouse arrow near the lower left corner of

the large square and press the <LMB>. This is the
starting point (P1) of the cutting move. Move the mouse
arrow above that point and press the <LMB> again. This
point (P2) determines the direction of the cutting move.
Position the mouse arrow to the right of the vertical line
and press the <LMB>. This point (P3) indicates that the
® r3 tool compensation is to the right of the selected segment,
therefore, the inside of the square will be cut. The finish-
P2 @ ing cut path for the border is now on the screen. Figure
4.2.5

18.Press <F3> to repeat the last function. Position the
mouse cursor near the lower left corner of the left-most
Sequence of Finish Path Points island and press the <LMB> (P1). Move the mouse
For Pockets arrow just to the right and press the <LMB> again (P2).
Move the mouse arrow below the island and press the
F/'gu/'e 425 <LMB> again (P3). A finish cut path is now around the
island. Figure 4.2.6.

Pl @

19.Repeat Step 17 for last two islands. The screen should
now look like Figure 4.2.7.

File Switch Edit Drow View Opfions CAH  lelp
Ddiiad ey SEXOABPLES . CDM

P1 P2

o
P3

Sequence of Finish Path Points
For Islands

Figure 4.2.6

Intities: 16 Tool Paths: 161 Zoom=l 1 4 13.0000 ¥ E.1000 Z

Figure 4.2.7 Completed Tool Path
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20.Press <CTRL>-N to the make the CNC file.

Tutorial

(ROUf/ﬂg E)(amp/e) The differences between the milling example and the routing

example are as follows:

1. The material size and type is 2" x 2" x 0.40" wax
in the milling example and 12" x 12" x 0.75" wood
in the routing example.

2. The visual and cursor grids are 0.2" and 0.025"
respectively in the milling example and from 1.0"
and 0.05" respectively in the routing example.

3. The selected tool is #3 (0.125" Std. Endmill) in
the milling example and #4 (0.375" Ball Endmill)
in the routing example.
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Appendix A
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The numbers on the top of the keys are the scan (or "make") codes. These codes are used for
programming the active jog key for any axis and direction.
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